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DISCLAIMER

All rights reserved. Information, technical data and tutorials contained in this document are proprietary under copyright law 
of  MicroEJ S.A. Without written permission from MicroEJ S.A., copying or sending parts of the document or the entire document 
by any means to third parties is not permitted. Granted authorizations for using parts of the document or the entire document 

do not mean MicroEJ S.A. gives public full access rights.

The information contained herein is not warranted to be error-free.

MicroEJ® and all relative logos are trademarks or registered trademarks of MicroEJ S.A. in France and other Countries.

Other trademarks are proprietary of their respective owners.
Java  is Sun Microsystems’ trademark for a technology for developing application software and deploying it in cross-platform, networked environments. When it is used in this site without adding the “ ” symbol, it includes 

implementations of the technology by companies other than Sun. Java , all Java-based marks and all related logos are trademarks or registered trademarks of Sun Microsystems Inc, in the United States and other Countries.
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• Goal:

o Provide an overview of the development tools provided to developers to debug an 
application

o Illustrate the use of the development tools

• Development tools categories:

o Runtime & Post-Mortem Debugging Tools

o Memory Inspection Tools (debug memory corruption, leaks)

o Static Analysis Tools

o GUI Application Debugging Tools (bottlenecks identification, rendering issues)

• The following icons are used in the next slides:

o : tool only working on Simulator

o : tool only working on the Device

o No icon means that the tool is working on the Device and on the Simulator.
V3.0 Mar. 2025© MICROEJ 2025

OVERVIEW
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DEVELOPMENT TOOLS OVERVIEW
TOOLS RUNTIME & POST-

MORTEM
MEMORY INSPECTION STATIC ANALYSIS TOOLS GUI DEBUGGING TOOLS

Core Engine VM Dump 

Debug on Device

Debug on Simulator

Port Qualification Tool (PQT)

SystemView 

Logging & Message Libraries

Code Coverage

Memory Map Analyzer

Heap Dumper / Analyzer

Heap Usage Monitoring

Core Engine MEMORY integrity check

SonarQube / Klocwork (Java/C)

Null Analysis

UI Flush Visualizer

UI MWT & Widget Debug Utilities
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Hardware required:

• NXP i.MX RT1170 Evaluation Kit (EVKB) + micro-USB cable + RK055HDMIPI4MA0 display panel

• More information about the Evaluation Kit: NXP i.MX RT1170 User Manual

Environment Setup:

• Follow the NXP i.MX RT1170 Evaluation Kit Getting Started to setup your environment and 
run a demo application on the Virtual Device and on the i.MX RT1170 Evaluation Kit.

• Note: the next slides are using IntelliJ IDEA with MicroEJ plugin for IntelliJ IDEA 1.1.0. This training 
supports all other available IDEs (Android Studio, VS Code, …)

This training requires the Getting Started to be completed until the 
Run an Application on the i.MX RT1170 Evaluation Kit section (included).

V3.0 Mar. 2025© MicroEJ 2025

PREREQUISITES

The path to the NXP i.MX RT1170 VEE Port sources 
should be as short as possible and contain no 
whitespace or non-ASCII character.

https://www.nxp.com/part/RK055HDMIPI4MA0
file:///C:/Users/acolleux/Downloads/MIMXRT1170EVKBHUG-1.pdf
https://docs.microej.com/en/latest/SDK6UserGuide/gettingStartedIMXRT1170.html#sdk-6-getting-started-imxrt1170
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GET TRAINING RESOURCES

• Download and extract the training resources provided with this training, it should contain:

o example-java-widget/

o slide-container/

o fill_array_heap_corruption.c

o jdwp-server-1.0.4.jar

V3.0 Mar. 2025© MICROEJ 2025

ENVIRONMENT SETUP (1/4)
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OPEN THE EXAMPLE-JAVA-WIDGET PROJECT

• Open IntelliJ IDEA.

• If no project is opened in your IDE yet, 
click on Open.
Otherwise, go to File > Open.

• Browse to the VEE Port sources folder:
example-java-widget

• Click on OK.

• The project sources appear in the Projects view.

V3.0 Mar. 2025© MICROEJ 2025

ENVIRONMENT SETUP (2/4)
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VEE PORT SELECTION

• Get the path to the NXP i.MX RT1170 VEE Port (e.g. C:\workspaces\training\nxpvee-mimxrt1170-
evk\nxpvee-mimxrt1170-evk)

• Add the path to the VEE Port in the settings.gradle.kts file of the example-java-widget project:

• In the build.gradle.kts file of the example-java-widget project, add the dependency to the VEE Port:

• Reload the Gradle project to see the NXP i.MXRT1170 VEE Port project in the IDE:

V3.0 Mar. 2025© MICROEJ 2025

ENVIRONMENT SETUP (3/4)

rootProject.name = “widget-examples"
includeBuild("C:\\workspaces\\training\\nxpvee-mimxrt1170-evk\\nxpvee-mimxrt1170-evk")

dependencies {
    implementation("ej.api:edc:1.3.5")

    //Uncomment the microejVee dependency to set the VEE Port or Kernel to use
    microejVee("com.nxp.vee.mimxrt1170:vee-port:3.0.0")
}



9

ADD CUSTOM NATIVE FUNCTION

A native function needs to be implemented in the BSP to run the sample on the device:

• Copy/Paste fill_array_heap_corruption.c in the BSP project (e.g. copy it in nxpvee-mimxrt1170-evk 
/bsp/vee/src/main).

• Add it to CMakeLists.txt (nxpvee-mimxrt1170-evk/bsp/vee/scripts/armgcc/CMakeLists.txt):

V3.0 Mar. 2025© MICROEJ 2025

ENVIRONMENT SETUP (4/4)
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Run the sample on the Simulator and on the Device to make sure that the setup is correct:

V3.0 Mar. 2025© MICROEJ 2025

CHECK THE ENVIRONMENT SETUP

• Go to the Gradle tasks view

• Run the runOnSimulator task:

• Run the runOnDevice task. Make sure the hardware is 
properly setup (cf. Prerequisites)
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Example-Java-Widget
Overview

Introduction to the 
Example-Java-Widget 
project

V3.0 Mar. 2025© MICROEJ 2025
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This project is a fork of 
Example Widget 8.1.0, bugs have been 
explicitly added.

The next slides will present those bugs 
and explain how to fix them.

V3.0 Mar. 2025© MICROEJ 2025

GUI OVERVIEW
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The application is composed of the following packages:

• Animated image: provides a page with an animated image widget 
producing a GUI freeze

• Carousel: typical page without bugs

• Circular Dotted Progress: provides a page that produces a memory 
leak

• Circular Slider: provides a page having a rendering issue

• Common: provides a navigation framework and common resources 
used by the application

• Main: main page of the application

• Radio Button: provides a page generating a heap memory corruption

Each package contains:

• A  Page class, describing the layout of the page

• A Widget package containing the widgets of the page

V3.0 Mar. 2025© MICROEJ 2025

PROJECT STRUCTURE
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Debug the 
BSP C Code

Start a Debug Session in VS 
Code

V3.0 Mar. 2025© MICROEJ 2025
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This section describes how to debug C code running on the NXP i.MXRT1170 using Visual Studio 
Code and GDB.

This section is not MicroEJ specific.

A GDB debugger will be required in the next slides.
You can skip those slides if you already have a GDB client working to debug the NXP 
i.MXRT1170.

Requirements:

• Install Visual Studio Code (https://code.visualstudio.com/)

• In VS Code, install the MCUXpresso extension for VS Code:

V3.0 Mar. 2025© MICROEJ 2025

OVERVIEW

https://code.visualstudio.com/
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• Enable the DEBUG mode by setting RELEASE=0 in nxpvee-mimxrt1170-
evk\bsp\vee\scripts\set_project_env.bat:

V3.0 Mar. 2025© MICROEJ 2025

ENABLE THE DEBUG MODE
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SELECT THE DEBUG BUILD MODE

VS Code allows to build, flash and debug embedded projects.

Open the NXP i.MX RT1170 VEE Port project in VS Code:

• In VS Code, go to File > Open Folder...

• Browse to the VEE Port sources folder:
nxpvee-mimxrt1170-evk

• Click on OK.

Once the project is opened:

• Open the MCUXpresso plugin view.

• Open the Build Configurations section in the PROJECTS view.

• Set flexspi_nor_sdram_debug_evkb as the default build 
configuration.

V3.0 Mar. 2025© MICROEJ 2025

BSP DEBUGGING IN VS CODE (1/2)
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Make sure that the example-java-widget project is running on the device.

Open the NXP i.MX RT1170 VEE Port project in VS Code:

• In VS Code, go to File > Open Folder...

• Browse to the VEE Port sources folder:
nxpvee-mimxrt1170-evk

• Click on OK.

Once the project is opened:

• Open the MCUXpresso plugin view.

• Right-click on the project.

• Select Debug (as the application is 
already running on the device).

V3.0 Mar. 2025© MICROEJ 2025

BSP DEBUGGING IN VS CODE (2/2)
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The debug view opens and the application runs on the device:

V3.0 Mar. 2025© MICROEJ 2025

DEBUG VIEW IN VS CODE

A control bar is 
available to 

start/stop/pause 
the debugging

The Debug Console allows to 
type GDB commands

Refer to VS Code 
documentation for more 

information.

https://code.visualstudio.com/docs/cpp/cpp-debug#_gdb-lldb-and-lldbmi-commands-gdblldb
https://code.visualstudio.com/docs/cpp/cpp-debug#_gdb-lldb-and-lldbmi-commands-gdblldb
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In case of connection issue to the target, reset the debug 
probe selection via the MCUXpresso plugin:

• Select the MCUXpresso plugin in the left banner.

• Right-click on the project name and select Reset Probe 
Selection.

• Start the debug again.

If the issue persists, unplug/plug the USB cable and turn 
OFF/ON the device:

V3.0 Mar. 2025© MICROEJ 2025

TROUBLESHOOTING
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Runtime & 
Post-Mortem 

Debugging Tools

Debug the Application code

V3.0 Mar. 2025© MICROEJ 2025
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• Tools:
o Core Engine VM Dump

o Debug on Device

o Debug on Simulator

o Port Qualification Tools (qualify a VEE Port)

o Event Tracing & Logging*

o Code Coverage*

• Example:

o Debug a deadlock in an application in the 
Simulator and on Device

V3.0 Mar. 2025© MICROEJ 2025

RUNTIME & POST-MORTEM DEBUGGING TOOLS

GUI freeze when entering a page
* Tool not introduced in this presentation, visit docs.microej.com for more information.

https://docs.microej.com/en/latest/VEEPortingGuide/coreEngine.html#vm-dump
https://docs.microej.com/en/latest/SDKUserGuide/debug.html#debug-on-device
https://docs.microej.com/en/latest/SDKUserGuide/debug.html#debug-on-simulator
https://docs.microej.com/en/latest/VEEPortingGuide/veePortQualification.html
https://docs.microej.com/en/latest/ApplicationDeveloperGuide/codeInstrumentationForLogging.html
https://docs.microej.com/en/latest/SDKUserGuide/codeCoverageAnalyzer.html
https://docs.microej.com/en/latest/
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REPRODUCE THE ISSUE

• Run the example-java-widget project the on 
Device:

• Enter the Animated Image page.

The GUI should freeze after the screen transition:

V3.0 Mar. 2025© MICROEJ 2025

DEBUG A DEADLOCK IN AN APPLICATION
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• Core Engine VM Dump is a diagnose tool to investigate unexpected behavior occurring on 
the target.

• When?
o Call the LLMJVM_dump() method in the Core Engine task at runtime to diagnose unexpected 

behavior (ex: UI freeze).

o Call the LLMJVM_dump() as a last resort in a fault handler to get a snapshot of the Core Engine, to 
check if the issue comes from a LLAPI or the underlying C code.

• What?
o Prints the state of the MicroEJ Core Engine to the standard output stream.

o For each Java thread, the Java stack trace, the name, the state and the priority are printed.

• Requirements:
o A way to read stdout (usually UART).

V3.0 Mar. 2025© MICROEJ 2025

CORE ENGINE VM DUMP (1/4)

https://docs.microej.com/en/latest/PlatformDeveloperGuide/platformConcepts.html#principle
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• Trigger the LLMJVM Dump from the 
debugger (see next slide):

HOW-TO?

• Example of LLMJVM Dump triggered from a 
fault handler:

V3.0 Mar. 2025© MICROEJ 2025

CORE ENGINE VM DUMP (2/4)
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TRIGGER THE LLMJVM DUMP FROM THE DEBUGGER (VS CODE / GDB)

• Start a serial terminal to get the application execution traces

• Start the debug session in VS Code

• Click the “Play” button to start the application

• Enter the Animated Image page

• Click the “Pause” button

• Run the following command in the Debug Console:

• Click the “Play” button, the VM dump can be see in the serial terminal
V3.0 Mar. 2025© MICROEJ 2025

CORE ENGINE VM DUMP (3/4)

-exec set $pc = __icetea__virtual__com_is2t_microjvm_mowana_VMTask___dump
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=================================== VM Dump ====================================
Java threads count: 3
Peak java threads count: 3
Total created java threads: 4
Last executed native function: 0x9014DDFB
Last executed external hook function: 0x00000000
State: idle, not notified
--------------------------------------------------------------------------------
Java Thread[1794]
name="Thread1" prio=5 state=MONITOR_QUEUED max_java_stack=492 current_java_stack=183
Locked on: java/lang/Object@0xC0081C4C (owned by thread[1281])

java/lang/Thread@0xC0082150:
    at com/microej/demo/widget/animatedimage/widget/AnimatedImage$1.run(AnimatedImage.java:190)
        Object References:
            - com/microej/demo/widget/animatedimage/widget/AnimatedImage$1@0xC00821B0
            - java/lang/Object@0xC0081C48
            - java/lang/Object@0xC0081C4C

--------------------------------------------------------------------------------
Java Thread[1281]
name="UIPump" prio=5 state=MONITOR_QUEUED max_java_stack=1296 current_java_stack=850
Locked on: java/lang/Object@0xC0081C48 (owned by thread[1794])

java/lang/Thread@0xC008047C:
    at com/microej/demo/widget/animatedimage/widget/AnimatedImage.renderContent(AnimatedImage.java:233)
        Object References:
            - com/microej/demo/widget/animatedimage/widget/AnimatedImage@0xC0081C2C
            - ej/microui/display/GraphicsContext@0xC008042C
            - java/lang/Object@0xC0081C4C
            - java/lang/Object@0xC0081C48

EXAMPLE OF DUMP

• Use the Stack Trace Reader to decode 
the stack trace

• A dead lock is identified in the stack 
trace, lock between threads “Thread1” 
and “UI Pump”

• The UI Tread (UI Pump) is locked
→ GUI Freeze

V3.0 Mar. 2025© MICROEJ 2025

CORE ENGINE VM DUMP (4/4)

https://docs.microej.com/en/latest/SDKUserGuide/stackTraceReader.html
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DEBUG ON SIMULATOR

• Use of JDWP (Java Debug Wire Protocol) to use 
Eclipse debugger

• Use mocks to simulate and debug corner cases 
of the target

• Debugger features:

o Breakpoints

o Step-by-step execution

o Variables and fields value monitoring

o Thread execution stacks list

DEBUG ON DEVICE

• Use of JDWP (Java Debug Wire Protocol) to use 
Eclipse debugger

• Need to setup the VEE Debugger Proxy

• Postmortem debug from a snapshot of the 
memory

• Debugger features:

o Breakpoints

o Step-by-step execution (planned)

o Variables and fields value monitoring

o Thread execution stacks list

V3.0 Mar. 2025© MICROEJ 2025

SIMULATOR & DEVICE DEBUGGER

Note: import the Foundation Library Sources to the debugger to get the exact source code which 
is executed. 

https://docs.microej.com/en/latest/ApplicationDeveloperGuide/debuggerProxy.html
https://docs.microej.com/en/latest/SDKUserGuide/debug.html#foundation-library-sources
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Debug on Device

Debug the Application Code 
on the Device

V3.0 Mar. 2025© MICROEJ 2025
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The VEE Debugger Proxy is an implementation of the Java Debug Wire protocol (JDWP) for 
debugging Applications executed by MICROEJ VEE. 

• VEE Debugger Proxy principle:

• Available since Architecture 8.1

V3.0 Mar. 2025© MICROEJ 2025

VEE DEBUGGER PROXY PRINCIPLE

• No VEE Port update required

• Steps:

1. Generate a VEE memory dump script for the 
target / toolchain 

2. Run the application Executable on target

3. Dump the memory of the running Executable 
using the C Debugger using the VEE memory 
dump script

4. Run the VEE Debugger Proxy in a Command 
Prompt

5. On the MicroEJ Simulator, run a Remote Java 
Application Debugging session

https://docs.microej.com/en/latest/ApplicationDeveloperGuide/debuggerProxy.html
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• The VEE Debugger Proxy tool jdwp-server-1.0.4 
is required to generate the VEE memory dump 
script. 
The tool is provided in the training package.

• The example-java-widget project provides the 
generateDumpScript task that allows the user 
to generate the VEE memory dump script:

This task is declared in the build.gradle.kts, it is 
based on the command line provided in the VEE 
Debugger Proxy documentation:

Note that this task is configured to generate a GDB 
dump script.

V3.0 Mar. 2025© MICROEJ 2025

GENERATE THE VEE MEMORY DUMP SCRIPT (1/2)

https://docs.microej.com/en/latest/ApplicationDeveloperGuide/debuggerProxy.html
https://docs.microej.com/en/latest/ApplicationDeveloperGuide/debuggerProxy.html


34

Run the generateDumpScript task:

• The application is built and flashed on the device,

• The dump script is generated in the build/generated folder:

V3.0 Mar. 2025© MICROEJ 2025

GENERATE THE VEE MEMORY DUMP SCRIPT (2/2)
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• Once the vee-memory-dump.gdb file is generated, open VS Code.

• Attach to the device in VS Code (cf. Debug the BSP C Code).

V3.0 Mar. 2025© MICROEJ 2025

DUMP THE DEVICE MEMORY (1/3)
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• To make sure that the Core engine is not running when the dump is performed, it is 
recommended to create a breakpoint at a specific safe point (Core Engine hooks or native 
function).

• Otherwise, make sure that the Core engine is not running when pausing the debugger (see 
Call Stack section in VS Code):

V3.0 Mar. 2025© MICROEJ 2025

DUMP THE DEVICE MEMORY (2/3)

Core Engine 
is running

Core Engine is 
NOT running

https://docs.microej.com/en/latest/ApplicationDeveloperGuide/debuggerProxy.html#with-gnu-debugger-gdb
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3. Heap dumps are generated in the 
output folder:

Note: the output folder is specified 
when generating the vee-memory-
dump.gdb script.

In VS Code, run the vee-memory-dump.gdb script file to dump 
the memory:

1. Pause the debugger:

2. Run the following command in the Debug Console view:

V3.0 Mar. 2025

DUMP THE DEVICE MEMORY (3/3)

-exec source C:\[YOUR_PATH]\vee-memory-dump.gdb

© MICROEJ 2025
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The example-java-widget project provides the 
generateDumpScript task that allows the user to 
run the VEE debugger proxy:

This task is declared in the build.gradle.kts, it is 
based on the command line provided in the VEE 
Debugger Proxy documentation:

The tool takes the dumped .hex files as input.

V3.0 Mar. 2025© MICROEJ 2025

RUN THE VEE DEBUGGER PROXY (1/2)

https://docs.microej.com/en/latest/ApplicationDeveloperGuide/debuggerProxy.html
https://docs.microej.com/en/latest/ApplicationDeveloperGuide/debuggerProxy.html
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Run the runVeeDebuggerProxy task:

• The tool is launched in the console:

V3.0 Mar. 2025© MICROEJ 2025

RUN THE VEE DEBUGGER PROXY (2/2)
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In IntelliJ IDEA:

• Click on Run > Edit Configurations….

• Click on + button (Add New 
Configuration).

• Select Remote JVM Debug.

• Click on the New launch configuration 
button.

• Give a name to the launcher in the Name 
field.

• Set the debug host to localhost and port 
to 8000.

• Click on the Debug button.

V3.0 Mar. 2025© MICROEJ 2025

RUN A REMOTE JAVA APPLICATION DEBUG SESSION
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The following debug state can be seen when pausing the debugger and the threads:

V3.0 Mar. 2025© MICROEJ 2025

GET THE POST-MORTEM DEBUGGING STATE (1/2)
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The 2nd Thread state can also be seen:

V3.0 Mar. 2025© MICROEJ 2025

GET THE POST-MORTEM DEBUGGING STATE (2/2)
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Debug on Simulator

Debug the Application Code 
on the Simulator

V3.0 Mar. 2025© MICROEJ 2025
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• Execute the runOnSimulator Gradle task with the following options:

• The console opens with the following message, click on Attach debugger to start the debug session:

V3.0 Mar. 2025© MICROEJ 2025

DEBUG ON THE SIMULATOR (1/2)

-P"debug.mode"=true -P"debug.port"=8000
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• Pause the Debugger once the freeze occurs.

• The same state that the debug on device view can be seen

V3.0 Mar. 2025

DEBUG ON THE SIMULATOR (2/2)

© MICROEJ 2025
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The interlock is caused by the synchronization of resource1 and resource2 objects on 2 different 
Threads:

• The renderContent method is called in the UIPump thread context

• Note: this method is called at every animation frame of the animated image

• The onShown method creates a TimerTask that is executed in the context of the Timer thread

• Note: this method is called once, when the Animated Page is shown

Fix: this code has been written for training purpose,
remove it to unlock the application.

V3.0 Mar. 2025© MICROEJ 2025

ISSUE ANALYSIS & FIX
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Port Qualification Tool

V3.0 Mar. 2025© MICROEJ 2025
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• The Port Qualification Tool (PQT) project provides the tools 
required to validate each component of a MicroEJ VEE Port. 

• After porting or adding a Foundation Library to a MicroEJ VEE 
Port, it is necessary to validate its integration.

• For each Low Level API, an Abstraction Layer implementation is 
required. The validation of the Abstraction Layer implementation 
is performed by running tests at two-levels:

o In C, by calling Low Level APIs (usually manually).

o In Java, by calling Foundation Library APIs (usually automatically 
using Platform Test Suite).

• PQT tests can be extended by the developer to support custom 
Foundation Libraries.

• Please refer to the Platform Qualification documentation for more 
information.

V3.0 Mar. 2025© MICROEJ 2025

PORT QUALIFICATION TOOL (1/2)

https://docs.microej.com/en/latest/glossary.html#term-Foundation-Library
https://docs.microej.com/en/latest/PlatformDeveloperGuide/platformQualification.html#platform-testsuite
https://docs.microej.com/en/latest/PlatformDeveloperGuide/platformQualification.html#platform-qualification
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• PQT tests are provided with a Test Suite 
project, to run tests automatically (CI or 
locally) 
→ Agility in the development flow

• A Test Suite contains one or more tests. 
For each test, the Test Suite Engine will:

o Build a MicroEJ Firmware for the test.

o Program and Run the MicroEJ 
Firmware onto the device.

o Retrieve the execution traces.

o Analyze the traces to determine 
whether the test has PASSED or 
FAILED.

o Append the result to the Test Report.

o Repeat until all tests of the Test Suite 
have been executed.

V3.0 Mar. 2025© MICROEJ 2025

PORT QUALIFICATION TOOL (2/2)

VEE Port Testsuite on Device Overview
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1. PQT: validate the vertical integration: Foundation Library > Abstraction Layer > C Library > 
Driver

2. Event Tracing & Logging: instrument the application with debug logs

3. Core Engine VM Dump: diagnosis tool to display the state of the MicroEJ Runtime and the 
MicroEJ threads on target (name, priority, stack trace, etc. )

4. Debugger (on device & simulator): analysis of an applicative issue

V3.0 Mar. 2025© MICROEJ 2025

KEY TAKEWAYS
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Memory Inspection 
Tools

V3.0 Mar. 2025© MICROEJ 2025
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• Tools:
o Memory Map Analyzer*

o Heap Dumper & Heap Analyzer

o Core Engine Memory integrity check

o Heap Usage Monitoring Tool*

• Examples:

o Investigate memory leaks

o Detect memory corruption of the 
Core Engine heap

V3.0 Mar. 2025© MICROEJ 2025

MEMORY INSPECTION TOOLS

Out Of Memory exception in a GUI 
application

* Tool not introduced in this presentation, visit docs.microej.com for more information.

https://docs.microej.com/en/latest/SDK6UserGuide/memoryMapAnalyzer.html
https://docs.microej.com/en/latest/SDKUserGuide/heapAnalyzer.html
https://docs.microej.com/en/latest/VEEPortingGuide/coreEngine.html#check-internal-structure-integrity
https://docs.microej.com/en/latest/ApplicationDeveloperGuide/heapUsageMonitoring.html
https://docs.microej.com/en/latest/
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PRINCIPLE

When the Executable of an Application is built, a 
Memory Map file is generated:

This file can be visualized with the Memory Map 
Analyzer, an Eclipse IDE plugin. It displays the 
memory consumption of different features in the 
RAM and ROM.

USAGE

.map files can be opened using the Memory Map Analyzer plugin. 
Make sure the Eclipse IDE is installed with the required plugin, 
then launch it. 

• In Eclipse IDE, click on File > Open File… to open the .map file:

Note: it does not include the memory usage of the BSP project.
V2.1 Feb. 2025© MicroEJ 2025

MEMORY MAP ANALYZER

https://docs.microej.com/en/latest/SDK6UserGuide/tools.html#sdk6-microejtools
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• Heap Dumper is a tool that takes a snapshot of the heap. 
Generated files (.heap extension) are available in the application output folder.

• Heap Analyzer is a tool that allows to inspect the heap dumps. 
It provides the following features:

o Memory leaks detection

o Objects instances browse

o Heap usage optimization (using immortal or immutable objects)

o Comparison between Heap Dumps

• To generate .heap dump files, System.gc() must be called explicitly in the application code.

• .heap dump files can be generated in simulation and also dumped from the device.

V3.0 Mar. 2025© MICROEJ 2025

HEAP DUMPER & HEAP ANALYZER (1/8)



57

USAGE

Heap Dumper is a tool that allows to get a snapshot of the 
heap of an Application running on the Simulator or on a 
device.

To run the Heap Dumper on Simulator (IntelliJ IDEA / 
Android Studio):

• Right-Click on the runOnSimulator task.

• Click on Modify Run Configuration...

• Add the following option:

• Click on Run.

Or use this command line:

V3.0 Mar. 2025© MICROEJ 2025

HEAP DUMPER & HEAP ANALYZER (2/8)

-D"microej.option.s3.inspect.heap=true"

.\gradlew.bat runOnSimulator 
-D"microej.option.s3.inspect.heap=true"

Run Configuration options
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REPRODUCE THE ISSUE

• Once the Simulator is started, enter / leave the 
Circular Dotted Progress page
~10 times

• Get the error trace in the console:

• Close the Simulator.

• Heap Dumps are generated in the 
build/output/<fqnMainClass>/heapDump/ folder of the project, where 
<fqnMainClass> is the Fully Qualified Name of the Application Main class.
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HEAP DUMPER & HEAP ANALYZER (3/8)

Generated Heap 
Dump files
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IMPORT THE HEAP DUMPS

Heap Dumps can be opened using the Heap Analyzer plug-in. Make sure the Eclipse IDE is installed with 
the required plugin, then launch it. 

In Eclipse IDE, create a new empty Project:

• Go to File > New > Project…

• Select General > Project.

• Give it a name and click Finish.

• Copy paste the generated Heap Dumps into this project:
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HEAP DUMPER & HEAP ANALYZER (4/8)

https://docs.microej.com/en/latest/SDK6UserGuide/tools.html#sdk6-microejtools
https://docs.microej.com/en/latest/SDK6UserGuide/tools.html#sdk6-microejtools
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PROGRESSIVE HEAP USAGE ANALYSIS

The progressive heap usage tool allows to see the number 
of instances over time.
To use the tool:

• Select the last .heap file (e.g. heap-5.heap)

• Right-click on it and select
Heap Analyzer > Show progressive heap usage

The following view opens:

In the Threads tab, we can clearly notice that the memory 
leak is coming from the UIThread:

Browsing the types, we notice that the instances of some 
types are also growing (e.g. TimerTaskList):

Next step: compare 2 consecutive heap dumps focusing 
the types that are growing continuously.
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HEAP DUMPER & HEAP ANALYZER (5/8)
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COMPARE THE HEAP DUMPS

• Right-Click on 2 consecutive .heap files.
Preferably the ones generated just before the Out Of Memory error.

• Click on Compare With → Each Other.

• The Heap Viewer opens, select the following configuration:
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HEAP DUMPER & HEAP ANALYZER (6/8)
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• Heap Compare between .heap-3 and .heap-4:

Guidelines:

• Lots of new objects have been 
created (691 new instances)

• Use the compare by content 
option to discard objects that 
moved but have the same content

• Look for new objects that can have 
an impact (Thread, Timer, Page, 
Widget, StyleSheet) 

→ knowledge of the application 
required, need to understand the 
objects hierarchy

• Once an object has been picked, 
look its parent in the Instance 
Browser
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HEAP DUMPER & HEAP ANALYZER (7/8)

New Timer Instance referenced from 
AnimatedCircularDottedProgress 

class 
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• New Timer instance created each time the 
CircularDottedProgressPage is shown:

→ Memory leak is due to the useless Timer 
instances keeping a reference on the widget 
AnimatedCircularDottedProgress
Also, the TimerTask is never canceled

ROOT CAUSE ANALYSIS FIX

• Retrieve a global Timer instance (defined at 
application startup)

• Cancel the TimerTask once the 
CircularDottedProgressPage is hidden
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HEAP DUMPER & HEAP ANALYZER (8/8)

@Override
protected void onShown() {
    System.gc();
    this.startTime = Util.platformTimeMillis();
    final AnimatedCircularDottedProgress progress = this;
    Timer timer = ServiceFactory.getService(Timer.class, Timer.class);
    this.task = new TimerTask() {

       @Override
       public void run() {
          progress.tick();
       }
    };
    timer.schedule(this.task, 0, 100);
}

@Override
protected void onHidden(){
    if(this.task != null){
       this.task.cancel();
    }
    this.task = null;
}
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• The LLMJVM_checkIntegrity API checks the internal memory structure integrity of the Core Engine 
with the LLMJVM_checkIntegrity API to detect memory corruptions in native functions. 

• This feature is for Applications deployed on hardware devices only:

o If an integrity error is detected, the LLMJVM_on_CheckIntegrity_error hook is called and this 
method returns 0.

o If no integrity error is detected, a non-zero checksum is returned.

• Note: this function affects performance and should only be used for debug purpose.
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CORE ENGINE MEMORY INTEGRITY CHECK (1/3)

https://docs.microej.com/en/latest/PlatformDeveloperGuide/coreEngine.html#core-engine-check-integrity


65

REPRODUCE THE ISSUE

• Run the example-java-widget application on the device

• Enter the Radio Button page, click on one of the buttons

• The GUI should freeze, the Heap is corrupted

• Run the BSP Debug, the execution is stuck in a while loop because the CRC check of the VEE Heap failed:
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CORE ENGINE MEMORY INTEGRITY CHECK (2/3)
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ROOT CAUSE ANALYSIS

• The fillArrayDo native function writes outside 
the array memory area:

FIX

• Fix the implementation of fillArrayDo.
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CORE ENGINE MEMORY INTEGRITY CHECK (3/3)

void fillArrayDo(uint8_t * array, jint length){
 *(array-=2)=1; // Write outside of the array
}

void Java_com_microej_demo_widget_radiobutton_widget_RadioButton_fillArray(uint8_t * array, jint length){

 int32_t crcBefore = LLMJVM_checkIntegrity();
 fillArrayDo(array, length);
 int32_t crcAfter = LLMJVM_checkIntegrity();
 if(crcBefore != crcAfter){
    // Corrupted MicroJVM virtual machine internal structures
    while(1);
 }
}
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• Heap Dumper:

• Generates heap dumps (.heap file) on System.gc() execution

• Heap Analyzer features:

• Compare: compares two heap dumps, showing which objects were created, or garbage 
collected, or have changed values 
→ useful for memory leaks detection

• Heap Viewer: shows which instances are in the heap, when they were created, and attempts to 
identify problematic areas 
→ useful for memory optimization

• Core Engine Memory Integrity Check: detect memory corruptions in native functions.

• Heap Usage Monitoring Tool: estimate the heap requirements of an application.
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KEY TAKEWAYS
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Identify & Debug 
Performance 

Bottlenecks

Study done on a 
UI Application
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Tools:

• Flush Visualizer

• Refresh Strategy Highlighting

• SystemView

• MicroUI Event Buffer Dump

Example:

• Identify performance bottlenecks that 
prevents smooth slide animation

The next slides are using IntelliJ IDEA as 
IDE.

Note: For UI2 and former versions, please 
refer to MicroUI and multithreading for a 
description of the threading model.
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IDENTIFYING & DEBUGGING BOTTLENECKS

Slide animation between 2 pages

https://docs.microej.com/en/latest/ApplicationDeveloperGuide/UI/Simulation/flush-visualizer.html
https://docs.microej.com/en/latest/ApplicationDeveloperGuide/UI/Simulation/refresh-strategy-highlighting.html
https://docs.microej.com/en/latest/VEEPortingGuide/systemView.html
https://docs.microej.com/en/latest/VEEPortingGuide/uiInput.html#event-buffer
https://forum.microej.com/t/gui-microui-and-multithreading/652
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Flush Visualizer

Identify & Debug Bottlenecks on the 
Simulator using the Flush Visualizer 
tool
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Building smooth and visually appealing UI applications requires a 
keen focus on performance. To achieve efficient UI rendering, 
minimizing unnecessary work that consumes valuable CPU time 
is essential.

The Flush Visualizer is a tool designed to investigate potential 
performance bottlenecks in UI applications running on the 
Simulator. The Flush Visualizer provides the following 
information:

• A timeline with a step for each flush.

• A screenshot of what is shown on the display at flush time.

• The list of what is done before this flush (and after the previous 
one) organized as a tree.

• A node of the tree can be either a region (the display or a clip) 
or a drawing operation.

For more information, refer to the 
Flush Visualizer documentation.

V3.0 Mar. 2025© MICROEJ 2025

PRESENTATION

https://docs.microej.com/en/latest/ApplicationDeveloperGuide/UI/Simulation/flush-visualizer.html
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Requirement (already fulfilled by NXP i.MXRT1170 VEE Port):

• VEE Port using UI Pack 14.0.0 or later.

• Frontpanel using the Display widget module version 4.+.

Open the slide-container example provided in the training 
package.

Add the dependency to the VEE Port in the 
slide-container/build.gradle.kts file.

To enable the Flush Visualizer on Simulator:

• Set the ej.fp.display.flushVisualizer to true in the 
application options (configuration/common.properties)

• Click on Run.
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ENABLE THE FLUSH VISUALIZER

Application options of the 
slide-container sample
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Click on the Show next button, the Flush Visualizer displays a message in the Console:

A value of 100% indicates that the area drawn is equivalent to the surface of the region. 
A value of 200% indicates that the area drawn is equivalent to twice the surface of the region. 
A perfect application has 100% of its root region drawn but its very unlikely for an application that draws 
anything else than a rectangle or an image. 
A total area drawn between 100% to 200% is the norm in practice because widgets often overlap. 

However, if the total area drawn is bigger than 200%, that means that the total surface of the region was 
drawn more than twice. Probably meaning that a lot of drawings are done above others. 

→ Next steps are about Identifying those drawings to reduce number of drawings done (or their surface).
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REPRODUCE THE ISSUE
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The Flush Visualizer report is accessible in the project output 
folder. It can be visualized in a web browser:

The report can also be opened clicking this button on the 
Front Panel:

V3.0 Mar. 2025© MICROEJ 2025

FLUSH ANALYZER REPORT
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Open the report and move the slider to the flush frame 
corresponding to the 401% of drawings (e.g. frame 242):

The report is available at the bottom of the page.

You should observe the report displayed beside.

The following information are provided:

• The operations before a flush are structured as a tree, 
where nodes represent either:
 a region (display or clip) 
 a drawing operation.

• Each region has defined bounds, can contain other nodes, 
and displays the percentage of its parent region it covers.

• Some drawings compute their coverage percentage

• Each region provides a summary of the total percentage 
covered recursively.
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REPORT ANALYSIS (1/2)
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SLIDE-CONTAINER PAGE BREAKDOWN
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REPORT ANALYSIS (2/2)
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Taking a look at the report, we notice that the page is 
actually rendered 2 times, exactly the same way:
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ROOT CAUSE ANALYSIS

public void tick(int value, boolean finished) {
    // Move the 2 pages
    updatePosition(value, leftChild, rightChild);
    if (finished) {
       // Refresh on the newly visible child.
       restore();
    }
}

1st

drawing
of the page

2nd 

drawing
of the page

Taking a look at the code, we notice that the 
page is fully redrawn when the transition 
animation is over (SlideContainer class):

1st drawing of the page 
updatePosition()

2nd drawing of the page 
restore()
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Run the updatePosition() code only when the animation is running:
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FIX PROPOSAL

public void tick(int value, boolean finished) {
    if (finished) {
       // Refresh on the newly visible child.
       restore();
    }else{
       // Move the 2 pages
       updatePosition(value, leftChild, rightChild);
    }
}

Next step: investigate why the area drawn is still above 200% (not part of this training)
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Refresh Strategy 
Highlighting

Identify & Debug Bottlenecks on 
the Simulator using the Refresh 
Strategy Highlighting

V3.0 Mar. 2025© MICROEJ 2025



80

This tool is complementary to the Flush Visualizer tool.

A buffer refresh strategy is responsible for making sure that what is shown on the display 
contains all the drawings—the ones done since the last flush and the past. 

To achieve that, it detects the drawn regions and refreshes the necessary data in the back 
buffer.

This information can also be used to understand what happens for each frame in terms of 
drawings and refreshes. It may be beneficial to identify performance issues.

The drawn and restored regions can be very different depending on the selected strategy and 
the associated options. See Buffer Refresh Strategy for more information about the different 
strategies and their behavior.

See Refresh Strategy Highlighting documentation for more information about this tool.
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REFRESH STRATEGY HIGHLIGHTING

https://docs.microej.com/en/latest/VEEPortingGuide/uiBRS.html#section-brs
https://docs.microej.com/en/latest/ApplicationDeveloperGuide/UI/Simulation/refresh-strategy-highlighting.html
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The following highlights can be enabled:

• Drawn Region(s)

• Restored Region(s)

• Dirty Region(s)

Enable the highlights in the slide-container example:

• Open the configuration/common.properties file

• Add the following properties, one per highlight type:

• Save common.properties 

• Run the application on Simulator

• Highlights are displayed in the Simulator. They can also be 
visualized in the Flush Visualizer report.
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ENABLE THE REFRESH STRATEGY HIGHLIGHTING

ej.fp.brs.drawnColor=0xff00ff00 // GREEN color
ej.fp.brs.restoredColor=0xffff00ff // PURPLE color
ej.fp.brs.dirtyColor=0x200000ff // BLUE color
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The render area of the CircularIndeterminateProgress widget (green 
area in DOCK LEFT) is taking all the height of the screen. 

Analysis:

• The CircularIndeterminateProgress widget is included in a Dock 
Container (see SlideContainerDemo class):

• The style configuration of the widget is not defining any size 
constraint (see SlideContainerDemo class):

→ The widget fills all the space available in the left part of the Dock 
container.

V3.0 Mar. 2025
© MICROEJ 2025

ANALYSIS

D
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DOCK TOP

DOCK CENTER

CircularIndeterminateProgress progress = new CircularIndeterminateProgress();
dock.addChildOnLeft(progress);

private static Stylesheet createStylesheet() {
       CascadingStylesheet stylesheet = new CascadingStylesheet();
       …
       style = stylesheet.getSelectorStyle(new TypeSelector(CircularIndeterminateProgress.class));
       style.setColor(POMEGRANATE);
       style.setVerticalAlignment(Alignment.VCENTER);
       style.setPadding(new UniformOutline(PADDING_MARGIN));
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The refresh area could be reduced to fit the size of the 
CircularIndeterminateProgress widget.

This would allow to save some CPU time, avoiding useless drawing and 
potentially improving the fluidity of the animation.

Update the style configuration of the example (createStylesheet method in the 
SlideContainerDemo class) to set an optimal dimension to the 
CircularIndeterminateProgress widget:

Run the updated code on Simulator to check that the refresh area has been 
reduced.

© MICROEJ 2025

REDUCE THE REFRESH AREA OF THE WIDGET

private static Stylesheet createStylesheet() {
    CascadingStylesheet stylesheet = new CascadingStylesheet();
     …
    style = stylesheet.getSelectorStyle(new TypeSelector(CircularIndeterminateProgress.class));
    style.setColor(POMEGRANATE);
    style.setDimension(OptimalDimension.OPTIMAL_DIMENSION_XY);
    style.setVerticalAlignment(Alignment.VCENTER);
    style.setPadding(new UniformOutline(PADDING_MARGIN));

Before widget 
style update

After widget 
style update
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Run the sample on the device.

The transition is laggy when clicking on the Show Next button (see slide-
container/videos/slide_containrer_nxp_rt1170_non-optimized.m4v).

An estimated FPS count is provided in the logs:

→ This board is theoretically able to run GUI applications near 60FPS. The next steps are about 
investigating the bottlenecks in the application and in the VEE Port that prevent having a smooth 
animation.
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RUN THE APPLICATION ON THE DEVICE
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SystemView

Identify & Debug Bottlenecks on 
the Device using 
SEGGER SystemView

V3.0 Mar. 2025© MICROEJ 2025
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• SystemView is a real-time recording and visualization tool for embedded systems that reveals the actual 
runtime behavior of an application, going far deeper than the system insights provided by debuggers.

• SystemView can ensure a system performs as designed, can track down inefficiencies, and show unintended 
interactions and resource conflicts, with a focus on the details of every single system tick.

• A specific SystemView extension made by MicroEJ allows to trace the OS tasks and the MicroEJ Java threads 
at the same time.

• For example, it can be used to measure the rendering time of images in a GUI application: 

V3.0 Mar. 2025© MICROEJ 2025

SYSTEMVIEW

Background: 
4.5ms

Logo: 
1.7ms

Mascot: 7.7ms

Custom trace event to track the 
execution of the render() method

render()
starts

render()
stops
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The following software are required:

• Install SEGGER J-Link:

• Create the JLINK_INSTALLATION_DIR environment variable that points to the SEGGER J-Link installation 
directory (e.g. C:\Program Files\SEGGER\Jlink):

• Install SEGGER SystemView

The runtime traces of the application needs to be enabled to see MicroEJ VEE tasks activity in SystemView:

• Open the configuration file of the application project (e.g. common.properties):

• Set core.trace.enabled and core.trace.autostart to true
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SETUP THE ENVIRONMENT FOR SYSTEMVIEW (1/2)

https://www.segger.com/downloads/jlink/
https://www.segger.com/downloads/systemview/
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Enable SystemView in the VEE Port:

• Open CMakePresets.json file located in nxp-vee-mimxrt1170-
evk/bsp/vee/scripts/armgcc/CMakePresets.json 

• Set ENABLE_SYSTEM_VIEW to 1:

Remove the build folders of the BSP to ensure the ENABLE_SYSTEM_VIEW property to be taken into account 
during next build (nxp-vee-mimxrt1170-evk/bsp/vee/scripts/armgcc/):
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SETUP THE ENVIRONMENT FOR SYSTEMVIEW (2/2)
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SystemView is a SEGGER tool, consequently it requires a J-Link probe to be used.

There are 2 ways to use a J-Link probe with the NXP i.MX RT1170 EVK:

1. Option 1: Connect an external J-Link probe:
o Connect jumper JP5

o Connect the probe to the J1 Connector

2. Option 2: Reprogram the embedded probe of the EVK (MCU-Link):
o Unplug J86 and J43 connectors. Plug the J43 connector, then the J86.

o Make sure jumper JP5 is removed and the USB cable is connected to J86

o Run the following script: C:\nxp\MCU-LINK_installer_{version}\scripts\program_JLINK.cmd

o Turn OFF the EVK + unplug the J86 USB cable, then Connect jumper JP3 and turn the board 
back ON + plug J86

o Press SPACE

o Remove the JP3 jumper

o Turn OFF and ON the EVK + unplug / plug the J86 USB cable.

o The probe can be seen in the device manager:
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USE A J-LINK PROBE
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1. If not already done, enable the DEBUG mode by setting RELEASE=0 in nxpvee-mimxrt1170-
evk\bsp\vee\scripts\set_project_env.bat:

2. Update the FLASH_CMD variable to use a J-Link probe:

Once done, build and flash the application on the device using the runOnDevice task.
Once done, the following trace should appear in the console:

V3.0 Mar. 2025© MICROEJ 2025

UPDATE THE BUILD SCRIPT CONFIGURATION
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• Start SystemView (tested with version 3.32)

• Set the following recorder configuration:

• Once done, click on the Play button. 
The acquisition starts, 
events can be see in 
SystemView:
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START THE ACQUISITION ON SYSTEMVIEW
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MicroUI logs several actions when traces are enabled (see Event Tracing).

Those traces can be added in SystemView to ease the analysis:

• Copy the traces provided in the following section: 
https://docs.microej.com/en/latest/ApplicationDeveloperGuide/UI/MicroUI/traces.html#systemview-
integration  

• Warning: jump a line at the end of the line for it to be taken into account

• Save them in a SYSVIEW_MicroUI.txt file (the syntax of the file matters) in 
C:\Program Files\SEGGER\SystemView\Description

• Restart SystemView and start a new acquisition

• The UI events are now detailed:
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GET MICROUI DEBUG TRACES

https://docs.microej.com/en/latest/ApplicationDeveloperGuide/trace.html#event-tracing
https://docs.microej.com/en/latest/ApplicationDeveloperGuide/UI/MicroUI/traces.html#systemview-integration
https://docs.microej.com/en/latest/ApplicationDeveloperGuide/UI/MicroUI/traces.html#systemview-integration
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TRACE ANALYSIS
• Start a new acquisition in SystemView.

• Press the Show next button.

• Stop the acquisition.

• The following diagram can be seen:

• At a first glimpse, we can see that the CPU is fully loaded during the slide 
transition. There are no “Idle” events, all the time is spent in the UIPump 
thread.

Slide transition



95

• Custom traces can be added in SystemView to figure out which events are occurring during the slide transition.

• Follow the steps below to add a custom trace:

o Add Trace library in the build.gradle.kts:

o Reload the Gradle project to get the dependency. Otherwise, the wrong TRACE library might be imported 
(sun.java2d.windows.GDIRenderer)

o Create a new Tracer in the SlideContainer class:

o Update the doAnimation method to track the start and the end of the transition:

V3.0 Mar. 2025

© MICROEJ 2025

ADD A CUSTOM TRACE (1/2)

implementation("ej.api:trace:1.1.1")

private static final Tracer slideTracer = new Tracer("MyTracer", 1); // The Tracer object

private static final int MY_EVT_ID = 0; // The ID that will be used to track the slide transition event

private void doAnimation(final Widget leftChild, final Widget rightChild, int startX, final int endX) {

    . . .
    this.releasedAnimation = new MotionAnimation(getAnimator(), motion, new MotionAnimationListener() {
       @Override
       public void tick(int value, boolean finished) {

          . . .
             restore();
             slideTracer.recordEventEnd(MY_EVT_ID); // Finish the slide transition tracing when the animation ends
          }
       }
    });
    slideTracer.recordEvent(MY_EVT_ID); // Start the slide transition tracing when the animation starts
    this.releasedAnimation.start();
}
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• The custom MyTracer event needs to be added to SystemView description files in order to be taken 
into account during the analysis.

• Create a SYSVIEW_MyTracer.txt file in C:\Program Files\SEGGER\SystemView\Description

• Add the following content in it:

o Warning: jump a line at the end of the line for it to be taken into account: 

• Restart SystemView and start a new acquisition + press the Show next button in the application.

• The MyTracer events can be seen in the events view:
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ADD A CUSTOM TRACE (2/2)

0 MyTracer (MyTracer) Transition start | (MyTracer) Transition end
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TIMELINE OVERVIEW

The following events are occurring between MyTracer start and end:
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ANALYSIS (1/6)

What we can observe:

• The transition is during 
approximately 550ms → ideally it 
should last 400ms see 
(TRANSITION_DURATION in 
SlideContainer class)

• There are big “blocks” in the timeline 
(138.7ms, 144.4ms)

→ The next slide will provide a way to 
interpret the results
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LOOK FOR TIME CONSUMING OPERATIONS

• Go down in the events list, between MyTracer start and MyTracer end

• Look for the big operations, for example this drawing operation that took 175.9ms:

• Once identified, scroll up 175.9ms earlier to see what was the nature of the drawing operation:
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ANALYSIS (2/6)

This is a drawImage operation

→ Locate all the other “time consuming” 
operations until MyTracer end
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DRAWIMAGE OPERATIONS ARE THE MAIN BOTTLENECK

Most of the time-consuming operations are related to drawImage operations:
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ANALYSIS (3/6)

175.9 ms 54.6 ms 147.3 ms 146.5 ms

drawImage operations are taking 95% of the slide 
transition time.

We can see that there are 4 drawImage operations 
performed. It is related to the 4 FPS observed in the 
console logs.

The next steps are:

1. Check the application implementation to 
understand why / how drawImage operations are 
done.

2. Check that the drawImage LLAPI is properly 
implemented in the BSP (use hardware accelerator, 
front buffer located in a high speed memory, 
memory cache enabled, …)
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ABOUT THE SLIDE CONTAINER IMPLEMENTATION

The slide container sample is optimized for low 
CPU usage:

• Drawings are done as less as possible during 
the transition (from right to left).

• For each frame:

• The content previously drawn on the 
screen is reused in the next frame on the 
left part of the screen (like a screenshot).

• Only the right part of the screen is drawn 
(Green area).

• The screen content can be reused using the 
drawDisplayRegion API.
It allows to copy a part of the screen on 
itself.

• The drawDisplayRegion implementation 
is calling the drawImage API. This 
confirms the drawImage events seen in 
SystemView.
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ANALYSIS (4/6)
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ABOUT THE DRAWIMAGE IMPLEMENTATION

The drawImage method is implemented in 
the LLUI_PAINTER_impl.c source file.

The implementation chosen on the NXP 
i.MXRT1170 is performing a memcpy when it 
comes to copying the screen content on 
itself.

Check the Image Renderer documentation to 
learn more about the drawImage 
implementations.

Next step: perform benchmarks on the NXP 
i.MXRT1170 

V3.0 Mar. 2025© MICROEJ 2025

ANALYSIS (5/6)
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https://docs.microej.com/en/latest/VEEPortingGuide/uiImageCore.html#standard-formats-only-default
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PERFORM BENCHMARKS ON THE TARGET

• Knowing that drawImage operations are “taking too much time” to execute, benchmarks should be performed on 
the target to figure out which hardware element is the bottleneck.

• Several kinds of benchmarks can be executed:
o At the BSP level (see Core Testsuite Engine):

• EEMBC Coremark (see

• RAM speed tests

o At MICROEJ VEE level:

• Run GUI benchmarks in Java (see java-testsuite-runner-ui3)

Conclusions on NXP i.MXRT1170:

• The screen has a high resolution (1280x720), thus a high number of pixels to drive:
 1280x720x16BPP/8 ~ 1.8Mb to transfer each time the screen is fully refreshed

• Front buffers are located in External RAM due to memory requirements.

• The benchmarks are showing that External RAM to External RAM copy is the bottleneck when it comes to copy a 
such amount of data. Hardware accelerators such as DMA or PXP are not improving results in that case.

→ On NXP i.MXRT1170 it is more interesting to limit RAM to RAM copy and perform drawings using the CPU to get a 
better framerate.

V3.0 Mar. 2025© MICROEJ 2025

ANALYSIS (6/6)

The procedure on how to run 
benchmarks is not described in this 
training.

https://github.com/MicroEJ/VEEPortQualificationTools/tree/2.12.0/tests/core
https://github.com/MicroEJ/VEEPortQualificationTools/tree/2.12.0/tests/ui/ui3/java-testsuite-runner-ui3
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• Open the SlideContainer class of the slide-container example.

• Comment the Render implementation 1 (render() and renderContent() methods).

• Look for the Render implementation 2, uncomment the render() content method:

• Run the application on the device.

V3.0 Mar. 2025© MICROEJ 2025

UPDATE THE APPLICATION CODE
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• Click on the Show next button on the screen.

• The implementation looks way smoother, see video in 
slide-container/videos/slide_containrer_nxp_rt1170_optimized.m4v

• The FPS have increased to 60 FPS:

• Next step (not part of this training): to go further in the optimizations, override the renderContent 
method to only draw the 2 last children (the visible ones).

V3.0 Mar. 2025© MICROEJ 2025

RUN THE APPLICATION ON THE DEVICE



105

The SystemView Analysis shows that all drawImage operations are gone.
They have been replaced by many DRAW_STRING and FILL_RECTANGLE operations (corresponding to 
what is drawn on the screen).
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SYSTEMVIEW ANALYSIS OF IMPLEMENTATION 2 (1/2)

The transition duration is now close to the 
expected 400ms transition time (412 ms).

Note that the CPU load is still near 100% (almost 
no idle time in the timeline)

• This is due to the implementation of the slide 
animation. An Animator is used, it executes 
animations as fast as possible to get the best 
framerate. 

• Check the Animations implementation 
documentation to learn more about the 
various implementations available.

https://repository.microej.com/javadoc/microej_5.x/apis/index.html?ej/mwt/animation/Animator.html
https://docs.microej.com/en/latest/Tutorials/tutorialValidateGUIs.html#animations-implementation
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• The SystemView analysis results are available  
slide-container/systemView.
They have been exported to CSV format to perform 
a deeper analysis.

• Number of drawing operations:

• Implementation 1 (~10FPS): 54

• Implementation 2 (~60FPS): 925
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SYSTEMVIEW ANALYSIS OF IMPLEMENTATION 2 (2/2)
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MicroUI Event Buffer Dump
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MicroUI is using a circular buffer to manage the input 
events. 

As soon as an event is added, removed, or replaced in 
the queue, the event engine calls the associated 
Abstraction Layer API (LLAPI) 
LLUI_INPUT_IMPL_log_queue_xxx(). 
This LLAPI allows the BSP to log this event and to dump 
it later thanks to a call to LLUI_INPUT_dump() (see 
dump beside).

For more information, read MicroUI Event Buffer 
documentation.
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MICROUI EVENT BUFFER DUMP
============================== MicroUI FIFO Dump ===============================
---------------------------------- Old Events ----------------------------------
[27: 0x00000000] garbage
[28: 0x00000000] garbage
[...]
[99: 0x00000000] garbage
[00: 0x08000000] Display SHOW Displayable (Displayable index = 0)
[01: 0x00000008] Command HELP (event generator 0)
[02: 0x0d000000] Display REPAINT Displayable (Displayable index = 0)
[03: 0x07030000] Input event: Pointer pressed (event generator 3)
[04: 0x009f0063]    at 159,99 (absolute)
[05: 0x07030600] Input event: Pointer moved (event generator 3)
[06: 0x00aa0064]    at 170,100 (absolute)
[07: 0x02030700] Pointer dragged (event generator 3)
[08: 0x0d000000] Display REPAINT Displayable (Displayable index = 0)
[09: 0x07030600] Input event: Pointer moved (event generator 3)
[10: 0x00b30066]    at 179,102 (absolute)
[11: 0x02030700] Pointer dragged (event generator 3)
[12: 0x0d000000] Display REPAINT Displayable (Displayable index = 0)
[13: 0x07030600] Input event: Pointer moved (event generator 3)
[14: 0x00c50067]    at 197,103 (absolute)
[15: 0x02030700] Pointer dragged (event generator 3)
[16: 0x0d000000] Display REPAINT Displayable (Displayable index = 0)
[17: 0x07030600] Input event: Pointer moved (event generator 3)
[18: 0x00d00066]    at 208,102 (absolute)
[19: 0x02030700] Pointer dragged (event generator 3)
[20: 0x0d000000] Display REPAINT Displayable (Displayable index = 0)
[21: 0x07030100] Input event: Pointer released (event generator 3)
[22: 0x00000000]    at 0,0 (absolute)
[23: 0x00000008] Command HELP (event generator 0)
---------------------------------- New Events ----------------------------------
[24: 0x0d000000] Display REPAINT Displayable (Displayable index = 0)
[25: 0x07030000] Input event: Pointer pressed (event generator 3)
[26: 0x002a0029]    at 42,41 (absolute)
--------------------------- New Events' Java objects ---------------------------
[java/lang/Object[2]@0xC000FD1C
 [0] com/microej/examples/microui/mvc/MVCDisplayable@0xC000BAC0
 [1] null
================================================================================

https://docs.microej.com/en/latest/VEEPortingGuide/uiInput.html#event-buffer
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Debugging 
Rendering Issues

V3.0 Mar. 2025© MICROEJ 2025
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• Tools:

• Widget Debug Utilities

• MWT Debug Utilities 

• Example:

• Debug the rendering issue of a page

V3.0 Mar. 2025© MICROEJ 2025

IDENTIFY GUI RENDERING ISSUES

Rendering issue when entering an application page

https://docs.microej.com/en/latest/ApplicationDeveloperGuide/UI/Widgets/debug-utilities.html
https://docs.microej.com/en/latest/ApplicationDeveloperGuide/UI/MWT/how-to-debug.html
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Widget Debug Utilities

Debug tools provided in the 
Widget library

V3.0 Mar. 2025© MICROEJ 2025
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The Widget Library provides several Debug Utilities to investigate and troubleshoot GUI 
applications:

• Print the hierarchy of widgets and styles

• Print the path to a widget

• Count the number of widgets or containers

• Count the maximum depth of a hierarchy

• Print the bounds of a widget

• Print the bounds of all the widgets in a hierarchy

Check the Debug Utilities page for more information.

V3.0 Mar. 2025© MICROEJ 2025

WIDGET DEBUG UTILITIES (1/3)

https://docs.microej.com/en/latest/ApplicationDeveloperGuide/UI/Widgets/debug-utilities.html
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REPRODUCE THE ISSUE

• Run the example-java-widget project the on Simulator.

• Enter the Circular Slider Page to see the rendering issue:

V3.0 Mar. 2025© MICROEJ 2025

WIDGET DEBUG UTILITIES (2/3)
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ROOT CAUSE ANALYSIS

• The background is not redrawn when the page 
shows up

• Add the following code in the CircularSlider 
page to print the style hierarchy of the Desktop:

• The following output can be seen in the console:

→ There are only transparent backgrounds used in 
the widget hierarchy

FIX

• Check the default style configuration:

→ The default style is providing a transparent background.

• The CircularSlider page is not setting the background neither:

• Fix proposals:

• Set an opaque background in the default StyleSheet (if 
possible)

• Set the background in the StyleSheet of the CircularSlider page 
(at least on the top level widget of the CircularSlider page 
→ SimpleDock) V3.0 Mar. 2025© MICROEJ 2025

WIDGET DEBUG UTILITIES (3/3)

@Override
protected void onShown(){
    HierarchyInspector.printHierarchyStyle(getDesktop().getWidget());
    super.onShown();
}
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MWT Debug Utilities

Debug tools provided in the 
MWT library

V3.0 Mar. 2025© MICROEJ 2025



116

HIGHLIGHTING THE BOUNDS OF THE WIDGETS

• When designing a UI, it can be pretty convenient to highlight the bounds of each widget. Here are some 
cases where it helps:

• Verify if the layout fits the expected design

• Set the outlines (margin, padding, border)

• Check the alignment of the widget content inside its bounds

• Example with the Home page and the Wheel page:

V3.0 Mar. 2025© MICROEJ 2025

MWT DEBUG UTILITIES (1/3) 

Check the Debug Utilities page for more information.

https://docs.microej.com/en/latest/ApplicationDeveloperGuide/UI/MWT/how-to-debug.html
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MONITORING THE RENDER OPERATIONS

• It may not be obvious what/how exactly the UI is rendered, especially if:

• A widget is re-rendered from a distant part of the application code

• A specific RenderPolicy is used (e.g. OverlapRenderPolicy)

• The Widget library provides a default monitor implementation that prints the operations on the 
standard output.

• The logs produced also contain information about what is rendered (widget and area) and what code 
requested the rendering. 

• Example with the RadioButton page (application logs after click):

V3.0 Mar. 2025© MICROEJ 2025

MWT DEBUG UTILITIES (2/3) 

rendermonitor@ INFO: Render requested on com.common.PageHelper$2 > SimpleDock > OverlapContainer > SimpleDock > List > RadioButton at {0,0 87x25} of {221,116 87x25} by 
com.microej.demo.widget.radiobutton.widget.RadioButtonGroup.setChecked(RadioButtonGroup.java:47)
rendermonitor@ INFO: Render requested on com.common.PageHelper$2 > SimpleDock > OverlapContainer > SimpleDock > List > RadioButton at {0,0 87x25} of {221,166 87x25} by 
com.microej.demo.widget.radiobutton.widget.RadioButtonGroup.setChecked(RadioButtonGroup.java:50)
rendermonitor@ INFO: Render executed on  com.common.PageHelper$2 > SimpleDock > OverlapContainer > SimpleDock > List > RadioButton at {-221,-116 87x25} of {221,116 87x25}
rendermonitor@ INFO: Render executed on  com.common.PageHelper$2 > SimpleDock > OverlapContainer > SimpleDock > List > RadioButton at {-221,-141 87x25} of {221,141 87x25}

Click

Check the Debug 
Utilities page for more 
information.

https://docs.microej.com/en/latest/ApplicationDeveloperGuide/UI/MWT/how-to-debug.html
https://docs.microej.com/en/latest/ApplicationDeveloperGuide/UI/MWT/how-to-debug.html
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• Since an animator ticks its animations as often as possible, the animator may take 100% CPU usage if 
none of its animations requests a render.

• MWT notifies when none of the animations has requested a render during an animator tick:

• requestRender() is only executed when the widget is moving, or if the user is manipulating it.
The tick() method loops indefinitely if there is no animation to do.

 → Stop the animation when not required to save CPU time

MONITORING THE ANIMATORS

V3.0 Mar. 2025© MICROEJ 2025

MWT DEBUG UTILITIES (3/3) 

animatormonitor WARNING: None of the animations has requested a render during the 

animator tick. Animations list: 

[com.microej.demo.widget.carousel.widget.Carousel$1@2d6d4]

Check the Debug Utilities page for more information.

https://docs.microej.com/en/latest/ApplicationDeveloperGuide/UI/MWT/how-to-debug.html
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• SystemView: live analysis of an application with a cross view between RTOS & VEE threads
→ bottlenecks analysis & profiling

• Flush Visualizer: show the pixel surface drawn between two MicroUI front buffer flushes
→ avoid useless redraws, improve performances

• MWT & Widget Debug utilities: detect issues with the widget hierarchy
→ debug rendering issues

V3.0 Mar. 2025© MICROEJ 2025

KEY TAKEWAYS
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Static Analysis 
Tools

V3.0 Mar. 2025© MICROEJ 2025
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NULL ANALYSIS

Static analysis tools are helpful allies to prevent several classes of bugs.

• Use the Null Analysis tool to detect and prevent NullPointerException, one of the most common causes 
of runtime failure of Java programs.

V3.0 Mar. 2025© MICROEJ 2025

STATIC ANALYSIS TOOLS (1/3)

https://docs.microej.com/en/latest/SDK6UserGuide/nullAnalysis.html
https://repository.microej.com/javadoc/microej_5.x/apis/java/lang/NullPointerException.html
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SONARQUBE

• SonarQube  is an open source platform for continuous inspection of code quality. SonarQube offers 
reports on duplicated code, coding standards, unit tests, code coverage, code complexity, potential 
bugs, comments, and architecture.

• SonarQube can be integrated with CI tools to monitor code quality during the project life.

• To set it up on your MicroEJ application project, please refer to this documentation. (configures the set 
of rules relevant to the context of MicroEJ Application development)

V3.0 Mar. 2025© MICROEJ 2025

STATIC ANALYSIS TOOLS (2/3)

SonarQube code analysis 
performed inside Eclipse IDE

SonarQube code analysis 
performed on SonarQube server

https://docs.microej.com/en/latest/Tutorials/tutorialImproveCodeQuality.html#sonar-code-analysis
https://github.com/MicroEJ/ExampleTool-Sonar
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KLOCWORK

• Klocwork is another code analysis platform that 
can be integrated to MICROEJ SDK.
Documentation can be found here.

• Klocwork can be integrated with CI tools to monitor 
code quality during the project life.

V3.0 Mar. 2025© MICROEJ 2025

STATIC ANALYSIS TOOLS (3/3)

Klocwork code analysis performed on Klocwork 
server

Klocwork code analysis performed inside 
Eclipse IDE

https://docs.roguewave.com/en/klocwork/current/
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THANK YOU  
f o r  y o u r  a t t e n t i o n  !
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